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CHAPTER 1

Contents

1.1 GUI

Source code: https://github.com/fpgawars/icestudio

1.1.1 Menu

File

• New project: create a new project.

1

https://github.com/fpgawars/icestudio


icestudio Documentation, Release 0.2.0

• Open project: show a file dialog to open a project (.ice).

• Examples: contains all stored examples. A example is loaded as a project.

• Templates: contains all stored templates. A template is loaded as a project.

• Save: save the current project (.ice).

• Save as: show a save file dialog to save the current project (.ice).

• Import block: load a block file (.iceb) into the current project.

• Export as block: show a save file dialog to export the current project as a block file (.iceb).

• Export verilog: show a save file dialog to export the current verilog code file (.v).

• Export PCF: show a save file dialog to export the current pcf file (.pcf).

Note: When a project is exported as a block, all FPGA I/O information is removed.

Hint: Examples are stored in app/resources/examples. To create a new examples category just create a directory
there. To create a new example copy and paste a .ice file.

Edit

• Image path: set the project’s relative image path. This image will be shown in the exported block. For example,
a valid value can be: ‘resources/images/and.svg’.

• Language: select the application language: English, Spanish. This selection is stored in the app profile.

• Clear all: remove all blocks and wires from the graph.

• Clone selected: clone the selected block. It can also be done with Ctrl + c key.

• Remove selected: remove the selected block. It can also be done with Ctrl + x and Supr keys.

View

• Reset view: reset pan and zoom to its default values.

Boards

It contains the supported boards: Icezum, iCEstick, Go board. When a board is selected all I/O block combos are
updated and its current values removed.

Hint: This information is stored in the app/scripts/services/boards.service.js file. To support a new board just add its
information to this file.

Tools

• Verify: check the generated verilog source code.

• Build: generate the bitstream from the graphic source.
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• Upload: generate and upload the bitstream to the FPGA board.

• Install/Upgrade toolchain: install a python virtualenv in .icestudio/venv, apio and icestorm toolchain. It re-
quires Python 2.7 installed and Internet connection.

• Remove toolchain: remove the directories .icestudio and .apio.

Hint: Generated files are stored in _build directory.

Help

• View license: open the Icestudio’s license in a web browser.

• Version: show the current version.

• Documentation: open the Icestudio’s documentation in a web browser.

• Source code: open the Icestudio’s source code in a web browser.

• Community forum: open the FPGAwars forum in a web browser.

• About Icestudio: information about the application.

1.1.2 Blocks menu

Basic

It contains the basic blocks:

• code: code block. Ports are asked in a prompt dialog.

• input: input block. Block name is asked in a prompt dialog.

• output: output block. Block name is asked in a prompt dialog.

Note: Multiple input and output blocks can be created using the space separator. For example: x y z will create 3
blocks with those names. FPGA I/O ports values are set in the block combo box. These values can be set by searching
and also unset by doing click on the cross. Double click over input and output blocks allows to modify the block
name. In code block ports definition, input and output ports are separated by a space. Port names are separated by ,.
For example: a,b: input a and b, a,b c: input a and b, output c. Double click over code blocks allows to modify its
input and output ports.

Stored blocks

It contains all stored blocks sorted by categories. These menu is generated when the application starts.

Hint: Examples are stored in app/resources/blocks. To create a new block category just create a directory there. To
create a new block copy and paste a .iceb file.
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1.1.3 Graph

This is the main panel. It contains the blocks and the wires.

Pan & Zoom

Pan is performed using the mouse left button over the background. Zoom is performed using mouse wheel. Both
values can be reset in View > Reset view.

Select

Block selection is performed using the mouse right button. Blocks can be selected/unselected individually using
right-click/Ctrl+right-click, respectively. In addition, several blocks can be selected by a selection box. Selection is
cancelled when the background is clicked.
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Blocks examination

Non-basic blocks can be readonly examined by double clicking the block using the mouse left button. This is a
recursive action.

1.1. GUI 5
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Note: The examination path is stored in the breadcrumbs. This allows you to go back to any previous block.

1.2 How to...

1.2.1 Create a project

1. Create a new project

Go to Edit > New project, write your project’s name and press OK.
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2. Add your blocks

1. Code blocks

Click on basic > code, add the code ports. Input and output ports are separated by a space. Port names are
separated by a comma. E.g.: a,b c.

This block contains a text editor to write your module verilog code. Module header and footer are not required.

1.2. How to... 7
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2. Info blocks

Click on basic > info.

This block contains a text editor to add comments about the project.
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3. Input/Output blocks

Click on basic > input or basic > output, write the block’s name and press OK.

These blocks contain a FPGA pin selector depending on the selected board.

1.2. How to... 9
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4. Bit blocks

Click on bit > 0 or bit > 1.

These blocks are low and high logic drivers.
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5. Config block

Click on config > Input-config.

This block must be connected to input ports in order to configure a pull up.

1.2. How to... 11
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6. Logic blocks

Go to the logic menu and select a logic gate.
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3. Connect your blocks

1.2. How to... 13
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4. Select your board

Go to Boards menu and select Icezum, iCEstick or Go board.

1.2. How to... 15
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5. Set FPGA I/O pins

Select all Input/Output blocks’ pins.
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6. Save the project

Go to Edit > Save:

It will be saved as an .ice file.

1.2. How to... 17
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1.2.2 Upload a bitstream

1. Open a project

Go to Edit > Open project and select an .ice file.

2. Verify the project

Go to Tools > Verify.

This option checks the generated verilog code using apio verify.
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3. Build the project

Go to Tools > Build.

This option generates a bitstream using apio build.

1.2. How to... 19
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4. Upload the project

Connect your FPGA board and press Tools > Upload. This option uses apio upload.
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Note: If the FPGA toolchain is not installed, it will be installed automatically when any tool is pressed. It can also be
installed or removed in the menu Tools section.

1.2. How to... 21
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1.2.3 Create a block

1. Open a project

Go to Edit > Open project and select an .ice file.
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2. Verify the project

Go to Tools > Verify.

3. Export the project as a block

Go to Edit > Export as block.

It will be saved as an .iceb file.

1.2. How to... 23
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Note: Input/Output blocks will become new Block I/O pins.

1.2.4 Use a custom block

1. Open or create a new project

2. Import the custom block

Go to Edit > Import block and select an .iceb file.
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3. Examine the custom block

Complex blocks can be examined by double clicking the block.
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1.2.5 Include a list file

If your code block contains a list file(s), for example:

$readmemh("rom.list", rom);

1. Save the ice project

2. Copy the list file(s) in the project directory

3. Build and upload the project

1.3 Blocks

1.3.1 Definitions

Block

A block is an entity with input and output ports composed by blocks.

Its input and output ports are defined from its input and output block instances.

Extension: .iceb

1.3. Blocks 27



icestudio Documentation, Release 0.2.0

{
"graph": {
"blocks" : [],
"wires": []

},
"deps" : {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Block instances

{
"id": "",
"type": "",
"data": {},
"position": {
"x": 0,
"y": 0

}
}

Wire instances

{
"source": {
"block": "",
"port": ""

},
"target": {
"block": "",
"port": ""

},
"vertices": [

{
"x": 0,
"y": 0

}
]

}

1.3.2 Basic blocks

Input instance

This special block is used to define input blocks in a project. It has one output port named ‘out’.
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{
"id": "",
"type": "basic.input",
"data": {
"label": "a"

},
"position": {
"x": 0,
"y": 0

}
}

Output instance

This special block is used to define output blocks in a projects. It has one input port named ‘in’.

{
"id": "",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {
"x": 0,
"y": 0

}
}

Code instance

This special block is used to define verilog code in a block. It has input and output ports defined in value.ports field.

{
"id": "",
"type": "basic.code",
"data": {
"code": "// And gate\n\nassign o = a & b;\n",
"ports": {
"in": [
"a",
"b"

],
"out": [
"o"

]
}

},
"position": {
"x": 0,
"y": 0

}
}
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1.3.3 Simple blocks

Simple blocks contain only basic blocks. It has no dependencies.

Low block

File: low.iceb

Show/Hide code

{
"graph": {
"blocks": [

{
"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {

"in": [],
"out": [
"v"

]
}

},
"position": {
"x": 96,
"y": 96

}
},
{

"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
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"type": "basic.output",
"data": {
"label": "o"

},
"position": {
"x": 608,
"y": 192

}
}

],
"wires": [
{

"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {
"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Not block

File: not.iceb
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Show/Hide code

{
"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {

"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{

"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
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"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Or block

File: or.iceb

Show/Hide code

1.3. Blocks 33
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{
"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 80

}
},
{

"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y"

},
"position": {
"x": 64,
"y": 208

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {

"in": [
"a",
"b"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
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{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{

"source": {
"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{

"source": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

1.3.4 Complex blocks

Complex blocks contain not only basic blocks.
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Cnot block

File: cnot.iceb

Show/Hide code

{
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

},
"graph": {
"blocks": [

{
"id": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"type": "not",
"data": {},
"position": {
"x": 280,
"y": 248

}
},
{

"id": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"type": "or",
"data": {},
"position": {
"x": 464,
"y": 136

}
},
{

"id": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"type": "basic.input",
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"data": {
"label": "a"

},
"position": {
"x": 88,
"y": 248

}
},
{

"id": "c8c6eed3-548c-49c7-a162-282179d427b1",
"type": "basic.output",
"data": {
"label": "b"

},
"position": {
"x": 640,
"y": 136

}
},
{

"id": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"type": "low",
"data": {},
"position": {
"x": 280,
"y": 120

}
}

],
"wires": [
{

"source": {
"block": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"port": "19c8f68d-5022-487f-9ab0-f0a3cd58bead"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"port": "out"

},
"target": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "97b51945-d716-4b6c-9db9-970d08541249"
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}
},
{

"source": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "c8c6eed3-548c-49c7-a162-282179d427b1",
"port": "in"

}
}

]
},
"deps": {
"or": {

"graph": {
"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 80

}
},
{

"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y"

},
"position": {

"x": 64,
"y": 208

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 752,
"y": 144

}
},
{

"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {
"in": [
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"a",
"b"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{

"source": {
"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{

"source": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
},
"not": {
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"graph": {
"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {

"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
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"port": "c"
},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"low": {

"graph": {
"blocks": [
{

"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {
"in": [],
"out": [
"v"

]
}

},
"position": {
"x": 96,
"y": 96

}
},
{

"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {
"x": 608,
"y": 192

}
}

],
"wires": [
{
"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {
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"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
}

}
}

Dnot block

File: dnot.iceb

Show/Hide code

{
"image": "",
"state": {
"pan": {

"x": 0,
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"y": 0
},
"zoom": 1

},
"graph": {
"blocks": [

{
"id": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"type": "basic.input",
"data": {
"label": "button"

},
"position": {
"x": 104,
"y": 176

}
},
{

"id": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"type": "cnot",
"data": {},
"position": {
"x": 352,
"y": 240

}
},
{

"id": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"type": "not",
"data": {},
"position": {
"x": 352,
"y": 112

}
},
{

"id": "4c4d2ddd-a97d-4fcb-9c68-ba1149f25082",
"type": "basic.output",
"data": {
"label": "led0"

},
"position": {
"x": 552,
"y": 112

}
},
{

"id": "0e777320-de37-4dca-a077-51fbf10a6565",
"type": "basic.output",
"data": {
"label": "led1"

},
"position": {
"x": 552,
"y": 240

}
}

],
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"wires": [
{

"source": {
"block": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"port": "out"

},
"target": {
"block": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"port": "out"

},
"target": {
"block": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"port": "55c6c056-3630-4482-ad47-f4d9ee83b835"

}
},
{

"source": {
"block": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "4c4d2ddd-a97d-4fcb-9c68-ba1149f25082",
"port": "in"

}
},
{
"source": {

"block": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"port": "c8c6eed3-548c-49c7-a162-282179d427b1"

},
"target": {

"block": "0e777320-de37-4dca-a077-51fbf10a6565",
"port": "in"

}
}

]
},
"deps": {
"logic.not": {

"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": ""

},
"position": {
"x": 64,
"y": 144

}
},
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{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": ""

},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ~ a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "resources/images/not.svg",
"state": {
"pan": {
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"x": 0,
"y": 0

},
"zoom": 1

}
},
"cnot": {

"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

},
"graph": {
"blocks": [
{

"id": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"type": "not",
"data": {},
"position": {

"x": 280,
"y": 248

}
},
{

"id": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"type": "or",
"data": {},
"position": {

"x": 464,
"y": 136

}
},
{

"id": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"type": "basic.input",
"data": {
"label": "a"

},
"position": {

"x": 88,
"y": 248

}
},
{

"id": "c8c6eed3-548c-49c7-a162-282179d427b1",
"type": "basic.output",
"data": {
"label": "b"

},
"position": {

"x": 640,
"y": 136

}
},
{
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"id": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"type": "low",
"data": {},
"position": {
"x": 280,
"y": 120

}
}

],
"wires": [
{
"source": {
"block": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"port": "19c8f68d-5022-487f-9ab0-f0a3cd58bead"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"port": "out"

},
"target": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "97b51945-d716-4b6c-9db9-970d08541249"

}
},
{

"source": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "c8c6eed3-548c-49c7-a162-282179d427b1",
"port": "in"

}
}

]
},
"deps": {
"or": {

"graph": {
"blocks": [
{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
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"type": "basic.input",
"data": {
"label": "x"

},
"position": {

"x": 64,
"y": 80

}
},
{
"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y"

},
"position": {

"x": 64,
"y": 208

}
},
{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 752,
"y": 144

}
},
{
"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {
"in": [

"a",
"b"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
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"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{
"source": {

"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{
"source": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {

"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"not": {
"graph": {
"blocks": [
{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {

"x": 64,
"y": 144

}
},
{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {
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"x": 752,
"y": 144

}
},
{
"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [

"a"
],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {

"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{
"source": {

"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {

"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"low": {
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"graph": {
"blocks": [
{
"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {
"in": [],
"out": [

"v"
]

}
},
"position": {

"x": 96,
"y": 96

}
},
{
"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 608,
"y": 192

}
}

],
"wires": [
{
"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {

"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
}

}
},
"not": {

"graph": {
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"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {

"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"
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},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
}

}
}

1.4 Project

1.4.1 Definition

A project is a composition of blocks. It includes the FPGA board information.

Its input and output block instances have also the FPGA I/O values to allow the synthesis.

It can be exported as a block, by removing the FPGA board and I/O data.

Extension: .ice

{
"board": "",
"graph": {
"blocks" : [],
"wires": []

},
"deps" : {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}
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1.4.2 Examples

Low project

File: low.ice

Show/Hide code

{
"board": "icezum",
"graph": {
"blocks": [

{
"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {

"in": [],
"out": [
"v"

]
}

},
"position": {
"x": 96,
"y": 96

}
},
{

"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o",
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"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 608,
"y": 192

}
}

],
"wires": [
{

"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {
"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Not project
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File: not.ice

Show/Hide code

{
"board": "icezum",
"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x",
"pin": {
"name": "SW1",
"value": "10"

}
},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {

"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
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"y": 48
}

}
],
"wires": [
{

"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}
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Or project

File: or.ice

Show/Hide code

{
"board": "icezum",
"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x",
"pin": {
"name": "SW1",
"value": "10"

}
},
"position": {
"x": 64,
"y": 80

}
},
{

"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y",
"pin": {
"name": "SW2",
"value": "11"

}
},
"position": {
"x": 64,
"y": 208
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}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {

"in": [
"a",
"b"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{

"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{

"source": {
"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
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},
{

"source": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Cnot project

File: cnot.ice

Show/Hide code

{
"image": "",
"state": {
"pan": {
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"x": 0,
"y": 0

},
"zoom": 1

},
"board": "icezum",
"graph": {
"blocks": [

{
"id": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"type": "not",
"data": {},
"position": {
"x": 280,
"y": 248

}
},
{

"id": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"type": "or",
"data": {},
"position": {
"x": 464,
"y": 136

}
},
{

"id": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"type": "basic.input",
"data": {
"label": "a",
"pin": {
"name": "SW1",
"value": "10"

}
},
"position": {
"x": 88,
"y": 248

}
},
{

"id": "c8c6eed3-548c-49c7-a162-282179d427b1",
"type": "basic.output",
"data": {
"label": "b",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 640,
"y": 136

}
},
{

"id": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
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"type": "low",
"data": {},
"position": {
"x": 280,
"y": 120

}
}

],
"wires": [
{

"source": {
"block": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"port": "19c8f68d-5022-487f-9ab0-f0a3cd58bead"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"port": "out"

},
"target": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "97b51945-d716-4b6c-9db9-970d08541249"

}
},
{

"source": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "c8c6eed3-548c-49c7-a162-282179d427b1",
"port": "in"

}
}

]
},
"deps": {
"or": {
"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
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"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 80

}
},
{

"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y"

},
"position": {
"x": 64,
"y": 208

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 752,
"y": 144

}
},
{

"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {
"in": [
"a",
"b"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
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"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{

"source": {
"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{

"source": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
},
"not": {

"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {
"x": 752,

64 Chapter 1. Contents



icestudio Documentation, Release 0.2.0

"y": 144
}

},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
},
"low": {

"graph": {

1.4. Project 65



icestudio Documentation, Release 0.2.0

"blocks": [
{

"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {
"in": [],
"out": [
"v"

]
}

},
"position": {
"x": 96,
"y": 96

}
},
{

"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {
"x": 608,
"y": 192

}
}

],
"wires": [
{
"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {
"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

}
}
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Dnot project

File: dnot.ice

Show/Hide code

{
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

},
"board": "icezum",
"graph": {
"blocks": [

{
"id": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"type": "basic.input",
"data": {
"label": "button",
"pin": {

"name": "SW1",
"value": "10"

}
},
"position": {
"x": 104,
"y": 176

}
},
{

"id": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"type": "cnot",
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"data": {},
"position": {
"x": 352,
"y": 240

}
},
{

"id": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"type": "not",
"data": {},
"position": {
"x": 352,
"y": 112

}
},
{

"id": "4c4d2ddd-a97d-4fcb-9c68-ba1149f25082",
"type": "basic.output",
"data": {
"label": "led0",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 552,
"y": 112

}
},
{

"id": "0e777320-de37-4dca-a077-51fbf10a6565",
"type": "basic.output",
"data": {
"label": "led1",
"pin": {
"name": "LED1",
"value": "96"

}
},
"position": {
"x": 552,
"y": 240

}
}

],
"wires": [
{

"source": {
"block": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"port": "out"

},
"target": {
"block": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{
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"source": {
"block": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"port": "out"

},
"target": {
"block": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"port": "55c6c056-3630-4482-ad47-f4d9ee83b835"

}
},
{

"source": {
"block": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "4c4d2ddd-a97d-4fcb-9c68-ba1149f25082",
"port": "in"

}
},
{

"source": {
"block": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"port": "c8c6eed3-548c-49c7-a162-282179d427b1"

},
"target": {
"block": "0e777320-de37-4dca-a077-51fbf10a6565",
"port": "in"

}
}

]
},
"deps": {
"logic.not": {

"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": ""

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": ""

},
"position": {
"x": 752,
"y": 144

}
},
{
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"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ~ a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "resources/images/not.svg",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
},
"cnot": {

"image": "",
"state": {
"pan": {

"x": 0,
"y": 0
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},
"zoom": 1

},
"graph": {
"blocks": [
{

"id": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"type": "not",
"data": {},
"position": {

"x": 280,
"y": 248

}
},
{

"id": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"type": "or",
"data": {},
"position": {

"x": 464,
"y": 136

}
},
{

"id": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"type": "basic.input",
"data": {
"label": "a"

},
"position": {

"x": 88,
"y": 248

}
},
{

"id": "c8c6eed3-548c-49c7-a162-282179d427b1",
"type": "basic.output",
"data": {
"label": "b"

},
"position": {

"x": 640,
"y": 136

}
},
{

"id": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"type": "low",
"data": {},
"position": {

"x": 280,
"y": 120

}
}

],
"wires": [
{
"source": {
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"block": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"port": "19c8f68d-5022-487f-9ab0-f0a3cd58bead"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"port": "out"

},
"target": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "97b51945-d716-4b6c-9db9-970d08541249"

}
},
{

"source": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "c8c6eed3-548c-49c7-a162-282179d427b1",
"port": "in"

}
}

]
},
"deps": {
"or": {

"graph": {
"blocks": [
{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {

"x": 64,
"y": 80

}
},
{
"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
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"data": {
"label": "y"

},
"position": {

"x": 64,
"y": 208

}
},
{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 752,
"y": 144

}
},
{
"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {
"in": [

"a",
"b"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{
"source": {

"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",

1.4. Project 73



icestudio Documentation, Release 0.2.0

"port": "b"
}

},
{
"source": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {

"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"not": {
"graph": {
"blocks": [
{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {

"x": 64,
"y": 144

}
},
{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {

"x": 752,
"y": 144

}
},
{
"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [

"a"
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],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {

"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{
"source": {

"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {

"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"low": {

"graph": {
"blocks": [
{
"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {
"in": [],
"out": [

"v"
]
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}
},
"position": {

"x": 96,
"y": 96

}
},
{
"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 608,
"y": 192

}
}

],
"wires": [
{
"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {

"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
}

}
},
"not": {

"graph": {
"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
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{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
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"x": 0,
"y": 0

},
"zoom": 1

}
}

}
}

1.5 Compiler

The JSON structure of a project is a block definition.

Output verilog structure:

1. Modules

2. Main module

(a) Wires definition

(b) Wires connections

(c) Blocks instances

1.5.1 Implementation

Show/Hide code

1 /**
2 * @author Jesús Arroyo Torrens <jesus.jkhlg@gmail.com>
3 *
4 * June 2016
5 */
6

7 'use strict';
8

9 var fs = require('fs');
10 var sha1 = require('sha1');
11

12

13 function digestId(id, force) {
14 if (id.indexOf('-') != -1) {
15 return 'v' + sha1(id).toString().substring(0, 6);
16 }
17 else {
18 return id.replace('.', '_');
19 }
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20 return id;
21 }
22

23 function module(data) {
24 var code = '';
25

26 if (data &&
27 data.name &&
28 data.ports &&
29 data.content) {
30

31 // Header
32

33 code += 'module ';
34 code += data.name;
35 code += ' (';
36

37 var params = [];
38 var paramsSpace = 10 + data.name.length;
39

40 for (var i in data.ports.in) {
41 params.push('input ' + data.ports.in[i]);
42 }
43 for (var o in data.ports.out) {
44 params.push('output ' + data.ports.out[o]);
45 }
46

47 code += params.join(',\n' + new Array(paramsSpace).join(' '));
48

49 code += ');\n';
50

51 // Content
52

53 var content = data.content.split('\n');
54

55 content.forEach(function (element, index, array) {
56 array[index] = ' ' + element;
57 });
58

59 code += content.join('\n');
60

61 // Footer
62

63 code += '\nendmodule\n\n';
64 }
65

66 return code;
67 }
68

69 function getPorts(project) {
70 var ports = {
71 in: [],
72 out: []
73 };
74 var graph = project.graph;
75

76 for (var i in graph.blocks) {
77 var block = graph.blocks[i];
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78 if (block.type == 'basic.input') {
79 ports.in.push(digestId(block.id));
80 }
81 else if (block.type == 'basic.output') {
82 ports.out.push(digestId(block.id));
83 }
84 }
85

86 return ports;
87 }
88

89 function getContent(name, project) {
90 var content = '';
91 var graph = project.graph;
92

93 // Wires
94

95 for (var w in graph.wires) {
96 content += 'wire w' + w + ';\n'
97 }
98

99 // I/O connections
100

101 for (var w in graph.wires) {
102 var wire = graph.wires[w];
103 for (var i in graph.blocks) {
104 var block = graph.blocks[i];
105 if (block.type == 'basic.input') {
106 if (wire.source.block == block.id) {
107 content += 'assign w' + w + ' = ' + digestId(block.id) + ';\n';
108 }
109 }
110 else if (block.type == 'basic.output') {
111 if (wire.target.block == block.id) {
112 content += 'assign ' + digestId(block.id) + ' = w' + w + ';\n';
113 }
114 }
115 }
116 }
117

118 // Wires Connections
119

120 var numWires = graph.wires.length;
121 for (var i = 1; i < numWires; i++) {
122 for (var j = 0; j < i; j++) {
123 var wi = graph.wires[i];
124 var wj = graph.wires[j];
125 if (wi.source.block == wj.source.block &&
126 wi.source.port == wj.source.port) {
127 content += 'assign w' + i + ' = w' + j + ';\n';
128 }
129 }
130 }
131

132 // Block instances
133

134 var instances = []
135 for (var b in graph.blocks) {
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136 var block = graph.blocks[b];
137 if (block.type != 'basic.input' &&
138 block.type != 'basic.output' &&
139 block.type != 'basic.info') {
140

141 var id = digestId(block.type, true);
142 if (block.type == 'basic.code') {
143 id += '_' + digestId(block.id);
144 }
145 instances.push(name + '_' + id + ' ' + digestId(block.id) + ' (');
146

147 // Parameters
148

149 var params = [];
150 var paramsNames = [];
151 for (var w in graph.wires) {
152 var param = '';
153 var paramName = '';
154 var wire = graph.wires[w];
155 if (block.id == wire.source.block) {
156 paramName = digestId(wire.source.port);
157 }
158 else if (block.id == wire.target.block) {
159 paramName = digestId(wire.target.port);
160 }
161 if (paramName && paramsNames.indexOf(paramName) == -1) {
162 paramsNames.push(paramName);
163 param += ' .' + paramName;
164 param += '(w' + w + ')';
165 params.push(param);
166 }
167 }
168

169 instances.push(params.join(',\n') + '\n);');
170 }
171 }
172 content += instances.join('\n');
173

174 return content;
175 }
176

177 function verilogCompiler(name, project) {
178 var code = '';
179

180 if (project &&
181 project.graph) {
182

183 // Main module
184

185 if (name) {
186 var data = {
187 name: name,
188 ports: getPorts(project),
189 content: getContent(name, project)
190 };
191 code += module(data);
192 }
193
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194 // Dependencies modules
195

196 for (var d in project.deps) {
197 code += verilogCompiler(name + '_' + digestId(d, true), project.deps[d]);
198 }
199

200 // Code modules
201

202 for (var i in project.graph.blocks) {
203 var block = project.graph.blocks[i];
204 if (block) {
205 if (block.type == 'basic.code') {
206 var data = {
207 name: name + '_' + digestId(block.type, true) + '_' + digestId(block.id),
208 ports: block.data.ports,
209 content: block.data.code
210 }
211 code += module(data);
212 }
213 }
214 }
215 }
216

217 return code;
218 }
219

220 function pcfCompiler(project) {
221 var code = '';
222

223 for (var i in project.graph.blocks) {
224 var block = project.graph.blocks[i];
225 if (block.type == 'basic.input' ||
226 block.type == 'basic.output') {
227 code += 'set_io ';
228 code += digestId(block.id);
229 code += ' ';
230 code += block.data.pin.value;
231 code += '\n';
232 }
233 }
234

235 return code;
236 }
237

238 // Examples
239

240 var fs = require('fs');
241

242 function compare_string(s1, s2) {
243 var diff = [];
244 var string1 = s1.split(" ");
245 var string2 = s2.split(" ");
246 var size = Math.max(s1.length, s2.length);
247

248 for(var x = 0; x < size; x++) {
249 if(string1[x] != string2[x]) {
250 diff.push(string1[x]);
251 }
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252 }
253

254 return diff.join(' ');
255 }
256

257 function test_example(name, extension) {
258 var filename = ['..', 'resources', 'examples', name, name].join('/');
259 fs.readFile(filename + '.' + extension, 'utf8', function (err, data) {
260 if (err) throw err;
261

262 var example = JSON.parse(fs.readFileSync(filename + '.ice'));
263 if (extension == 'v') {
264 var s1 = verilogCompiler('main', example).replace(/[\r\n]/g, "");
265 }
266 else {
267 var s1 = pcfCompiler(example).replace(/[\r\n]/g, "");
268 }
269 var s2 = data.replace(/[\r\n]/g, "");
270

271 if (extension == 'v') {
272 process.stdout.write('Testing ' + name + ' v ...');
273 }
274 else {
275 process.stdout.write('Testing ' + name + ' pcf ...');
276 }
277 if (s1 == s2) {
278 process.stdout.write(' [OK]\n');
279 }
280 else {
281 process.stdout.write(' [Fail]\n');
282 process.stdout.write(compare_string(s1, s2) + '\n');
283 }
284 });
285 }
286

287 // Test examples
288

289 test_example('low', 'v');
290 test_example('low', 'pcf');
291 test_example('not', 'v');
292 test_example('not', 'pcf');
293 test_example('or', 'v');
294 test_example('or', 'pcf');
295 test_example('cnot', 'v');
296 test_example('cnot', 'pcf');
297 test_example('dnot', 'v');
298 test_example('dnot', 'pcf');
299

300 //console.log(verilogCompiler('main', JSON.parse(fs.readFileSync('../resources/examples/dnot/dnot.ice'))));
301 //console.log(pcfCompiler(JSON.parse(fs.readFileSync('../resources/examples/dnot/dnot.ice'))));

npm install fs sha1
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node compiler.js

1.5.2 Examples

Low project

File: low.ice

Show/Hide code

{
"board": "icezum",
"graph": {
"blocks": [

{
"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {

"in": [],
"out": [
"v"

]
}

},
"position": {
"x": 96,
"y": 96

}
},
{

84 Chapter 1. Contents



icestudio Documentation, Release 0.2.0

"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o",
"pin": {

"name": "LED0",
"value": "95"

}
},
"position": {
"x": 608,
"y": 192

}
}

],
"wires": [
{

"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {
"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Generates

module main (output v608bd9);
wire w0;
assign v608bd9 = w0;
main_basic_code_v68c173 v68c173 (
.v(w0)

);
endmodule

module main_basic_code_v68c173 (output v);
// Bit 0

assign v = 1'b0;
endmodule

set_io v608bd9 95
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Not project

File: not.ice

Show/Hide code

{
"board": "icezum",
"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x",
"pin": {
"name": "SW1",
"value": "10"

}
},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y",
"pin": {
"name": "LED0",
"value": "95"

}
},
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"position": {
"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {

"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{

"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}
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Generates

module main (input v0e28cb,
output vcbab45);

wire w0;
wire w1;
assign w0 = v0e28cb;
assign vcbab45 = w1;
main_basic_code_vd54ca1 vd54ca1 (
.a(w0),
.c(w1)

);
endmodule

module main_basic_code_vd54ca1 (input a,
output c);

// NOT logic gate

assign c = ! a;
endmodule

set_io v0e28cb 10
set_io vcbab45 95

Or project

File: or.ice

Show/Hide code

{
"board": "icezum",
"graph": {

88 Chapter 1. Contents



icestudio Documentation, Release 0.2.0

"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x",
"pin": {

"name": "SW1",
"value": "10"

}
},
"position": {
"x": 64,
"y": 80

}
},
{

"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y",
"pin": {
"name": "SW2",
"value": "11"

}
},
"position": {
"x": 64,
"y": 208

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {

"in": [
"a",
"b"

],
"out": [
"c"

1.5. Compiler 89



icestudio Documentation, Release 0.2.0

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{

"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{

"source": {
"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{

"source": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

Generates

module main (input v0e28cb,
input v3ca442,
output vcbab45);
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wire w0;
wire w1;
wire w2;
assign w0 = v0e28cb;
assign w1 = v3ca442;
assign vcbab45 = w2;
main_basic_code_vf4938a vf4938a (
.a(w0),
.b(w1),
.c(w2)

);
endmodule

module main_basic_code_vf4938a (input a,
input b,
output c);

// OR logic gate

assign c = a | b;
endmodule

set_io v0e28cb 10
set_io v3ca442 11
set_io vcbab45 95

Cnot project

File: cnot.ice

Show/Hide code

{
"image": "",
"state": {
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"pan": {
"x": 0,
"y": 0

},
"zoom": 1

},
"board": "icezum",
"graph": {
"blocks": [

{
"id": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"type": "not",
"data": {},
"position": {
"x": 280,
"y": 248

}
},
{

"id": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"type": "or",
"data": {},
"position": {
"x": 464,
"y": 136

}
},
{

"id": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"type": "basic.input",
"data": {
"label": "a",
"pin": {
"name": "SW1",
"value": "10"

}
},
"position": {
"x": 88,
"y": 248

}
},
{

"id": "c8c6eed3-548c-49c7-a162-282179d427b1",
"type": "basic.output",
"data": {
"label": "b",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 640,
"y": 136

}
},
{
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"id": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"type": "low",
"data": {},
"position": {
"x": 280,
"y": 120

}
}

],
"wires": [
{

"source": {
"block": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"port": "19c8f68d-5022-487f-9ab0-f0a3cd58bead"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"port": "out"

},
"target": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "97b51945-d716-4b6c-9db9-970d08541249"

}
},
{

"source": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "c8c6eed3-548c-49c7-a162-282179d427b1",
"port": "in"

}
}

]
},
"deps": {
"or": {

"graph": {
"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
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"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 80

}
},
{

"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y"

},
"position": {

"x": 64,
"y": 208

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 752,
"y": 144

}
},
{

"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {
"in": [

"a",
"b"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
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"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{

"source": {
"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{

"source": {
"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
},
"not": {

"graph": {
"blocks": [

{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {
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"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
},
"low": {
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"graph": {
"blocks": [
{

"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {
"in": [],
"out": [
"v"

]
}

},
"position": {
"x": 96,
"y": 96

}
},
{

"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {
"x": 608,
"y": 192

}
}

],
"wires": [
{
"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {
"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

}
}

Generates
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module main (input va1d1bb,
output vecf2e3);

wire w0;
wire w1;
wire w2;
wire w3;
assign w1 = va1d1bb;
assign vecf2e3 = w3;
main_not va44cd3 (
.v0e28cb(w1),
.vcbab45(w2)

);
main_or v0b7a71 (
.v0e28cb(w0),
.v3ca442(w2),
.vcbab45(w3)

);
main_low v2d7478 (
.v608bd9(w0)

);
endmodule

module main_or (input v0e28cb,
input v3ca442,
output vcbab45);

wire w0;
wire w1;
wire w2;
assign w0 = v0e28cb;
assign w1 = v3ca442;
assign vcbab45 = w2;
main_or_basic_code_vf4938a vf4938a (
.a(w0),
.b(w1),
.c(w2)

);
endmodule

module main_or_basic_code_vf4938a (input a,
input b,
output c);

// OR logic gate

assign c = a | b;
endmodule

module main_not (input v0e28cb,
output vcbab45);

wire w0;
wire w1;
assign w0 = v0e28cb;
assign vcbab45 = w1;
main_not_basic_code_vd54ca1 vd54ca1 (
.a(w0),
.c(w1)

);
endmodule
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module main_not_basic_code_vd54ca1 (input a,
output c);

// NOT logic gate

assign c = ! a;
endmodule

module main_low (output v608bd9);
wire w0;
assign v608bd9 = w0;
main_low_basic_code_v68c173 v68c173 (
.v(w0)

);
endmodule

module main_low_basic_code_v68c173 (output v);
// Bit 0

assign v = 1'b0;
endmodule

set_io va1d1bb 10
set_io vecf2e3 95

Dnot project

File: dnot.ice

Show/Hide code
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{
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

},
"board": "icezum",
"graph": {
"blocks": [

{
"id": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"type": "basic.input",
"data": {
"label": "button",
"pin": {

"name": "SW1",
"value": "10"

}
},
"position": {
"x": 104,
"y": 176

}
},
{

"id": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"type": "cnot",
"data": {},
"position": {
"x": 352,
"y": 240

}
},
{

"id": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"type": "not",
"data": {},
"position": {
"x": 352,
"y": 112

}
},
{

"id": "4c4d2ddd-a97d-4fcb-9c68-ba1149f25082",
"type": "basic.output",
"data": {
"label": "led0",
"pin": {
"name": "LED0",
"value": "95"

}
},
"position": {
"x": 552,
"y": 112
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}
},
{

"id": "0e777320-de37-4dca-a077-51fbf10a6565",
"type": "basic.output",
"data": {
"label": "led1",
"pin": {
"name": "LED1",
"value": "96"

}
},
"position": {
"x": 552,
"y": 240

}
}

],
"wires": [
{

"source": {
"block": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"port": "out"

},
"target": {
"block": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "327f1a9e-ba42-4d25-adcd-f7f16ac8f451",
"port": "out"

},
"target": {
"block": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"port": "55c6c056-3630-4482-ad47-f4d9ee83b835"

}
},
{

"source": {
"block": "88b3c210-c6f5-4cd3-a578-2e5ab8aa1562",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "4c4d2ddd-a97d-4fcb-9c68-ba1149f25082",
"port": "in"

}
},
{

"source": {
"block": "58c892ba-89a3-4da7-9d0a-56f2523bfd98",
"port": "c8c6eed3-548c-49c7-a162-282179d427b1"

},
"target": {
"block": "0e777320-de37-4dca-a077-51fbf10a6565",
"port": "in"

}
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}
]

},
"deps": {
"logic.not": {
"graph": {
"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": ""

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": ""

},
"position": {

"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ~ a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"
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}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "resources/images/not.svg",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"cnot": {

"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

},
"graph": {
"blocks": [
{

"id": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"type": "not",
"data": {},
"position": {

"x": 280,
"y": 248

}
},
{

"id": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"type": "or",
"data": {},
"position": {

"x": 464,
"y": 136

}
},
{

"id": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"type": "basic.input",
"data": {
"label": "a"
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},
"position": {
"x": 88,
"y": 248

}
},
{

"id": "c8c6eed3-548c-49c7-a162-282179d427b1",
"type": "basic.output",
"data": {
"label": "b"

},
"position": {
"x": 640,
"y": 136

}
},
{

"id": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"type": "low",
"data": {},
"position": {

"x": 280,
"y": 120

}
}

],
"wires": [
{
"source": {
"block": "d2a2eac1-f8b0-4e5b-a693-626f6d14b8e5",
"port": "19c8f68d-5022-487f-9ab0-f0a3cd58bead"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "55c6c056-3630-4482-ad47-f4d9ee83b835",
"port": "out"

},
"target": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "18c2ebc7-5152-439c-9b3f-851c59bac834"

}
},
{

"source": {
"block": "db6b84db-bc29-46d6-86a4-f48cc50c8076",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "97b51945-d716-4b6c-9db9-970d08541249"

}
},
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{
"source": {
"block": "ba7c5fb1-172d-4fa0-8a59-1905c4a71332",
"port": "664caf9e-5f40-4df4-800a-b626af702e62"

},
"target": {
"block": "c8c6eed3-548c-49c7-a162-282179d427b1",
"port": "in"

}
}

]
},
"deps": {
"or": {

"graph": {
"blocks": [
{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {

"x": 64,
"y": 80

}
},
{
"id": "97b51945-d716-4b6c-9db9-970d08541249",
"type": "basic.input",
"data": {
"label": "y"

},
"position": {

"x": 64,
"y": 208

}
},
{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 752,
"y": 144

}
},
{
"id": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"type": "basic.code",
"data": {
"code": "// OR logic gate\n\nassign c = a | b;",
"ports": {
"in": [

"a",
"b"
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],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "a"

}
},
{
"source": {

"block": "97b51945-d716-4b6c-9db9-970d08541249",
"port": "out"

},
"target": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "b"

}
},
{
"source": {

"block": "00925b04-5004-4307-a737-fa4e97c8b6ab",
"port": "c"

},
"target": {

"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"not": {
"graph": {
"blocks": [
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{
"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {

"x": 64,
"y": 144

}
},
{
"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {

"x": 752,
"y": 144

}
},
{
"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [

"a"
],
"out": [
"c"

]
}

},
"position": {

"x": 256,
"y": 48

}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {

"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{
"source": {

"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
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"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
},
"low": {
"graph": {
"blocks": [
{
"id": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"type": "basic.code",
"data": {
"code": "// Bit 0\n\nassign v = 1'b0;",
"ports": {
"in": [],
"out": [

"v"
]

}
},
"position": {

"x": 96,
"y": 96

}
},
{
"id": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"type": "basic.output",
"data": {
"label": "o"

},
"position": {

"x": 608,
"y": 192

}
}

],
"wires": [
{
"source": {
"block": "b959fb96-ac67-4aea-90b3-ed35a4c17bf5",
"port": "v"

},
"target": {

"block": "19c8f68d-5022-487f-9ab0-f0a3cd58bead",
"port": "in"
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}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {
"x": 0,
"y": 0

},
"zoom": 1

}
}

}
},
"not": {

"graph": {
"blocks": [
{

"id": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"type": "basic.input",
"data": {
"label": "x"

},
"position": {
"x": 64,
"y": 144

}
},
{

"id": "664caf9e-5f40-4df4-800a-b626af702e62",
"type": "basic.output",
"data": {
"label": "y"

},
"position": {
"x": 752,
"y": 144

}
},
{

"id": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"type": "basic.code",
"data": {
"code": "// NOT logic gate\n\nassign c = ! a;",
"ports": {
"in": [
"a"

],
"out": [
"c"

]
}

},
"position": {
"x": 256,
"y": 48
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}
}

],
"wires": [
{
"source": {
"block": "18c2ebc7-5152-439c-9b3f-851c59bac834",
"port": "out"

},
"target": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "a"

}
},
{

"source": {
"block": "5365ed8c-e5db-4445-938f-8d689830ea5c",
"port": "c"

},
"target": {
"block": "664caf9e-5f40-4df4-800a-b626af702e62",
"port": "in"

}
}

]
},
"deps": {},
"image": "",
"state": {
"pan": {

"x": 0,
"y": 0

},
"zoom": 1

}
}

}
}

Generates

module main (input v121a14,
output v31c150,
output v71e6a9);

wire w0;
wire w1;
wire w2;
wire w3;
assign w0 = v121a14;
assign w1 = v121a14;
assign v31c150 = w2;
assign v71e6a9 = w3;
assign w1 = w0;
main_cnot vc6f497 (
.va1d1bb(w1),
.vecf2e3(w3)

);
main_not v59fef8 (
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.v0e28cb(w0),

.vcbab45(w2)
);

endmodule

module main_logic_not (input v0e28cb,
output vcbab45);

wire w0;
wire w1;
assign w0 = v0e28cb;
assign vcbab45 = w1;
main_logic_not_basic_code_vd54ca1 vd54ca1 (
.a(w0),
.c(w1)

);
endmodule

module main_logic_not_basic_code_vd54ca1 (input a,
output c);

// NOT logic gate

assign c = ~ a;
endmodule

module main_cnot (input va1d1bb,
output vecf2e3);

wire w0;
wire w1;
wire w2;
wire w3;
assign w1 = va1d1bb;
assign vecf2e3 = w3;
main_cnot_not va44cd3 (
.v0e28cb(w1),
.vcbab45(w2)

);
main_cnot_or v0b7a71 (
.v0e28cb(w0),
.v3ca442(w2),
.vcbab45(w3)

);
main_cnot_low v2d7478 (
.v608bd9(w0)

);
endmodule

module main_cnot_or (input v0e28cb,
input v3ca442,
output vcbab45);

wire w0;
wire w1;
wire w2;
assign w0 = v0e28cb;
assign w1 = v3ca442;
assign vcbab45 = w2;
main_cnot_or_basic_code_vf4938a vf4938a (
.a(w0),
.b(w1),
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.c(w2)
);

endmodule

module main_cnot_or_basic_code_vf4938a (input a,
input b,
output c);

// OR logic gate

assign c = a | b;
endmodule

module main_cnot_not (input v0e28cb,
output vcbab45);

wire w0;
wire w1;
assign w0 = v0e28cb;
assign vcbab45 = w1;
main_cnot_not_basic_code_vd54ca1 vd54ca1 (
.a(w0),
.c(w1)

);
endmodule

module main_cnot_not_basic_code_vd54ca1 (input a,
output c);

// NOT logic gate

assign c = ! a;
endmodule

module main_cnot_low (output v608bd9);
wire w0;
assign v608bd9 = w0;
main_cnot_low_basic_code_v68c173 v68c173 (
.v(w0)

);
endmodule

module main_cnot_low_basic_code_v68c173 (output v);
// Bit 0

assign v = 1'b0;
endmodule

module main_not (input v0e28cb,
output vcbab45);

wire w0;
wire w1;
assign w0 = v0e28cb;
assign vcbab45 = w1;
main_not_basic_code_vd54ca1 vd54ca1 (
.a(w0),
.c(w1)

);
endmodule

module main_not_basic_code_vd54ca1 (input a,
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output c);
// NOT logic gate

assign c = ! a;
endmodule

set_io v121a14 10
set_io v31c150 95
set_io v71e6a9 96
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